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New Features in Instantis EnterpriseTrack 9.0 
Key enhancements include: 

 Timesheet improvements  
 Critical path display on the project schedule Gantt tab 
 Non-WBS improvements 
 Resource improvements 
 EnterpriseTrack Mobile 
 Custom field improvements 
 Ideation improvements 
 Finance template flexibility 
 Enhanced reports 
 Usability improvements 
 New user interface and icons 
 Administration and configuration support 
 Technical enhancements 
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PPM Features 
EnterpriseTrack 9.0 offers new project portfolio management features to enhance resource planning and timesheet 
functionality, improve the project schedule Gantt, and simplify management of non-WBS activities.  
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Timesheet Improvements 
EnterpriseTrack 9.0 provides these timesheet improvements: 
  
Timesheet Status Notification E-mails: Timesheet status notification emails are improved with three separate 
notification types: 

 Timesheet Approved 
 Timesheet Rejected 
 Timesheet Re-opened  

The notification type is displayed in the e-mail subject line, making the notifications more clear-and direct than 
previous e-mail notifications, which displayed only a generic timesheet status change notification in the subject line. 
  
Enhanced Support for Cross-Initiative Timesheet Approval: EnterpriseTrack has improved timesheet permissions 
for resource managers and enhanced support for cross-initiative timesheet approval. An alert is triggered if a resource 
manager cannot view timesheet categories belonging to another initiative. This helps simplify personnel and business 
practices for organizations that need to use the same resources on multiple initiatives. 
  
Timesheet Approval Delegation: EnterpriseTrack 9.0 enables project managers and resource managers to delegate 
timesheet approval responsibilities to a selected resource for a specified or indefinite length of time, such as during a 
vacation or illness. Delegates receive no additional permissions beyond timesheet approval. The My Delegations 
page enables you to view the delegations assigned to you as well as to add, edit, or delete delegations of your own. 

 

To access this feature: On the MyEnterpriseTrack menu on the Top Navigation Bar, select My Delegations to access 
the My Delegations page. Select the Assigned tab to view timesheet delegations assigned to you. Select the Manage 
tab to add, edit, or delete your own delegations.  
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Critical Path 

EnterpriseTrack 9.0 features new critical path functionality on the project schedule Gantt tab. This new feature helps 
project managers quickly identify the activities driving their project completion dates. Specify a minimum slack 
(float) value for critical activities and EnterpriseTrack determines critical activities and displays the critical path on 
the Gantt chart. 

 

The feature is enabled during system deployment (or reconfiguration) via an initiative-specific project feature setting 
on the Configuration Workbench. 

On the Application Configuration tab on the Administration Console, click the Minimum Slack for Critical Path link 
and then specify a value. Typically, activities with zero slack are considered critical. On the project schedule Gantt 
tab, select the Show Critical Path check box and reschedule the project to display the current critical path. View the Is 
Critical and Slack columns to confirm whether an activity is critical, or hover your cursor over a Gantt chart activity 
bar to view additional information, such as the current Plan Start and Completion dates and the activity's days of 
slack. Activities on the critical path are also displayed on the project schedule All tab, the Activity Details page, the 
My Work page, and in the Activity Detail report. 

 

To access this feature: On the Application Configuration tab in the Administration module, click the Minimum Slack 
for Critical Path link to specify the minimum number of days of slack (float) for critical activities. On the Project 
Schedule (roadmap) page for a selected project, click the Gantt tab, select the Show Critical Path check box, and then 
reschedule the project. 
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Non-WBS Improvements 

EnterpriseTrack 9.0 simplifies creation of non-WBS activities such as issues, risks, scope change requests, defects, 
and other project-level user-defined activities that your organization wishes to track. Redesigned, simpler forms make 
it easier for administrators to create non-WBS activity types in the Administration module and for users to create 
individual non-WBS activities on the Project menu. In addition, two preconfigured non-WBS activity types -- Issues 
and Risks -- are included with EnterpriseTrack out of the box. Non-WBS activity forms can be customized further 
using the Custom Fields link in the Administration module. 

 

To access this feature: On the Application Configuration tab in the Administration module, click the Non-WBS 
Schedules link to create new non-WBS activity types. To create an individual non-WBS activity (of a type defined in 
the Administration module), click Create on the Project menu on the Top Navigation bar. 
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Resource Improvements 
EnterpriseTrack 9.0 provides a number of resource improvements: 
  
Heat Map Threshold Customization: EnterpriseTrack 9.0 enables you to customize color thresholds for resource 
heat maps, which are displayed on the Resource Planning List page, the What-if View Scenarios page, and in Heat 
Map reports (Heat Map by Resource, Heat Map by Role, Heat Map by Project). The thresholds had previously been 
hard-coded and inaccessible to users. Now, organizations can customize the thresholds to support their own 
operational standards. In addition, column header, legend styles, and column header tool tips have been 
standardized on the Resource Planning List page, the What-if View Scenario page, and in the Heat Map Reports to 
eliminate inconsistencies. 

  

 
  
To access this feature: Click the Resource Heat Map Thresholds link on the Resource & Security Admin tab on the 
Administration Console. 
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TBD Capacity in Resource Modules: A setting has been added to the Resource & Security Admin tab on the 
Administration Console to include/exclude any capacity associated with TBD resource allocations in heatmaps and 
reports. 

  

 
  
To access this feature: Click the Include TBD Capacity in Resource Modules link on the Resource & Security 
Admin tab on the Administration Console. 
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Default Percentage Utilization: EnterpriseTrack 9.0 enables you to specify the default percentage utilization of 
resources and roles for each initiative. The default allocation had been 100%. Companies can now configure 
EnterpriseTrack to better support their business operations. Resource and role allocations can also be more easily 
edited with the option of specifying utilization in hours rather than a percentage of total capacity. 

  

 
  
To access this feature: Click the Default Percentage Utilization link on the Resource & Security Admin tab on the 
Administration Console.  
  
  
 
 
Resource View Improvements: General resource view functionality is enhanced in EnterpriseTrack 9.0 to improve 
usability and facilitate resource planning activities. 
  
Resource Planning Filters: In response to requests for more project-related filters in the Resource Planning 
section, the full complement of Project Basic filters is now available. This includes the following filters: 

 Project ID (was already in the Resource Planning section) 
 Project Name 
 Keyword 
 Project Status 

Project ID, Project Name, and Project Status have also been added as columns on the Resource Planning List page.  
  
Resource Details Assignments Tab: A Role column is added to the Assignments tab in the Resource Details dialog 
box and values in the Project Name column are now links that navigate directly to the project. 
  
Resource Planning Heat Map Data: As a default, six months of heat map data is now displayed on the Resource 
Planning List page instead of the previous four months. 
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EnterpriseTrack Mobile 
Access EnterpriseTrack 9.0 on your Android or iOS device using EnterpriseTrack Mobile. Open the app, enter server 
information for the EnterpriseTrack account you want to access, and then sign in using your usual login ID and 
password. The mobile application supports dashboards and timesheets. 
  
The applications are available for download from the Google Play or Apple App store. 
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Dashboards 

Use EnterpriseTrack Mobile's dashboard functionality to quickly view and analyze project finances, resource 
utilization, and other information. Tap Dashboards on the main menu to view a list of available dashboards, and then 
tap a dashboard to view it. Swipe to switch between dashboard graphs and tap to expand the active dashboard image.  
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Timesheet Approval 

Use EnterpriseTrack Mobile to view, approve or reject timesheets. Tap Timesheets on the main menu to view a list of 
timesheets awaiting your approval. Select Edit to begin marking timesheets for approval or rejection. Tap once to 
mark a timesheet for approval, or tap twice to mark it for rejection. When you are finished marking timesheets, select 
submit to apply your changes.  
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Customer Success 
 EnterpriseTrack 9.0 provides multiple new features that respond to customer requests for increased usability. 
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Custom Field Improvements 
EnterpriseTrack 9.0 includes the following custom field improvements: 

 New Field Types: Two new custom field types are added -- Global Resource and Label. 
 Sorting Order: In list type custom fields, values are sorted by the order in which they were entered. 
 Context-Sensitive Option: Now available for custom fields in project requests. 
 Default Values: No longer mandatory for custom fields that have been configured as Required. 

These feature upgrades, which were all enhancement requests, improve usability. 
  

 
  
To access these features: Click the Custom Fields link on the Application Configuration tab on the Administration 
Console. 
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Usability Improvements 
EnterpriseTrack 9.0 provides the following improvements to improve usability: 

 Project Number: Project ID numbers are added to various pages and lists throughout the application to help 
users identify and organize projects. 

 Roles on the Project Requests listing page: The Project Requests listing page is updated to enable viewing 
and filtering by roles. Click the Columns icon and then select a role to add it as a column on the listing page; 
available roles are grouped by initiative. This enhancement also enables you to filter roles by individual 
resources. 

 New filters in Advanced Search: Expanded filters and advanced search options enable searching by first 
name and last name. In Project Requests Advanced Search, search by role, by project, and roadmap types. 

 Projects Associated With field: The Projects Associated With field and Project Requests Associated With 
field in Advanced Search for Projects and Project Requests are improved to enable filtering on any resource. 

 Pull-down values: Administrators can now sort the order of pull-down values in the Document Type, Note 
Type, and Project Priority fields. 

 

 
  
To access these features: Click Project Requests on the Go To menu on the Top Navigation bar to access the Project 
Requests listing page. On the View menu, click Columns to select a role column to display. Click Advanced Search to 
access the new filters and the enhanced Associated With field. The Associated With field is also available in 
Advanced Search on the Projects listing page. 
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Ideation Improvements 
EnterpriseTrack 9.0 provides multiple improvements to the Idea module designed to simplify and facilitate the formal 
process of creating ideas: 

 Create a New Idea page layout: The page contains a new single-column format and modern type font. The 
Create a New Idea page and the external Idea Portal now share the same UI behavior and field requirements. 

 Primary Contact: Idea title and primary contact information only are required in order to create a new idea. 
The name of the person who submitted the idea is no longer required. 

 Submitter Confidentiality: The Hide Submitter Name? field on the Create a New Idea page is renamed 
Keep Submitter Details Confidential for clarity and consistency. 

 Configuration Workbench: Options added to the Configuration Workbench enable administrators to hide 
any of the five statement and notes fields in the Idea Details section on either the Create a New Idea page or 
the Display Idea page. In addition, the Idea Evaluation Matrix, Process Defect, and Measureable fields can be 
suppressed through the Global Feature Settings link. Another new link, Statements and Notes Mapping, 
enables administrators to modify mapping between Idea Details and Project Request Details fields. 

 Idea Owner filters: The Idea Owner field now supports advanced filtering and text input. 
 Printable: The Display Idea page is now printable. 

 

To access these features: On the Ideas listing page, click Create. 
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Enhanced Reports 

EnterpriseTrack 9.0 provides a number of enhancements to the Reports module: 

 Ad-hoc Reports: A new column is added to the Project Template to display roles/titles that are specific to 
each initiative enabled in your system. 

 New Reports: The following new reports are added to the existing pre-defined standard reports:  
o Metrics Listing Report 
o Project & Metrics Template 
o Non-WBS Activity Report 
o Project Summary By Project Source 
o Project Summary By Functional Area 
o Project Summary By Process Area 

 Activity Detail Report: A new output option is added, enabling resource information to be split into multiple 
rows per project with each resource role displayed in a separate row. 

 

To access these features: Click Reports on the Go To menu on the Top Navigation bar. 
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Finance Template Flexibility 
  
EnterpriseTrack 9.0 provides new options to enable administrators to adjust the finance template to better serve their 
company's business needs. Administrators can now add up to 300 finance elements. In addition, finance elements can 
be edited by changing the parent category for elements, the parent group for categories, and by changing their display 
order. Changes are transparent to end users. 
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User Experience 
EnterpriseTrack 9.0 improves the user experience with a new UI and icons that align the application with other Oracle 
Primavera products. 
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New User Interface and Icons  
Instantis EnterpriseTrack 9.0 features a new user interface and icons for a more contemporary look, consistent with 
other Oracle Primavera applications. 
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Administration and Configuration Support 
 EnterpriseTrack 9.0 provides multiple new features to help administrators more efficiently manage their systems. A 
brief description of each feature follows. 
  
Backup and Restore Release Upgrades: A new Backup button on the Updates tab allows administrators to back up 
the database prior to performing a system upgrade. The backup can be used to restore the database if the upgrade 
causes data problems. 

  
Configuration Workbench Selective Import of Global Values: When importing a FastTrack template, 
administrators can now choose to preserve the global settings that currently exist or selectively override them 
with settings from the template. 

  
Configuration Workbench Link Reorganization: Links on the Configuration Workbench/Administrator's Module 
are reorganized into more intuitive groupings to improve usability. Links associated with disabled features are 
displayed but inactive. In addition, an on-page search feature helps administrators locate links quickly. 

  
Configuration Workbench Updates Tab Filters: A filter row has been added to the Update History table on the 
Updates tab on the Configuration Workbench/Administration Console to help administrators quickly find specific 
update entries on what, in some systems, may become a very long list. Updates can be filtered by the following 
columns: Operation, Version, Updated By, Comments. 

 

Project Request Statement and Notes Fields: Administrators can now use the Feature Settings link on the 
Configuration Workbench Deployment Options tab to set the project request Statement and Notes fields as mandatory 
fields. Administrators can also choose to hide the Statement and Notes detail fields. 
  
Initiative Sandboxing: Administrators can now view only the settings and options that pertain to the initiative to 
which they are associated. In order to view all global settings, an administrator must have access to all initiatives 
enabled in the system. 

  
Administrator Accounts: The instantis_sa account is renamed sys_admin. The functionality and permissions for 
these accounts remain unchanged. In addition, the sys_admin can now configure a Temporary Administrator 
(tmp_admin) account with the same capabilities and permissions as the sys_admin but which can be 
activated/deactivated as needed. 

  
Default User Authentication: Administrators can now change the default user authentication method when 
EnterpriseTrack is in the Reconfigure mode. 

  
Enhanced Password Security: New password options enable administrators to exercise more control over the 
security of their system. New password settings include: 

 Minimum Number of Characters in Password  
 Do not Allow Passwords Containing Login ID or Name  
 Requires at Least One Numeric Character 
 Requires at Least One Lower and One Upper Case Character 
 Requires at Least One Symbol 

 

Feature Settings Page Improvements: The Feature Settings page provides new labels and descriptions for increased 
clarity and ease of use.  
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Technical Enhancements 
 EnterpriseTrack 9.0 provides new integration APIs, described below: 
  
Data Import Module API: The Data Import API enables other programs to access the EnterpriseTrack Data Import 
module directly. It automates data import of all types into EnterpriseTrack, reducing the time, effort, and input errors 
associated with manual data import.  

  
Finance API for ERP Integration: The API enables you to access the EnterpriseTrack finance template to create, 
read, update, and delete data from project finance tables based on the template. Organizations use the finance template 
in different ways -- some to show budget/plan financial data, some to show actual costs/expenses, and others a 
combination of plan and actuals. The API is designed for maximum flexibility to accommodate a wide range of 
template uses as well as future enhancements to the template. 

  
The API supports three primary objects as well as authentication functions common to EnterpriseTrack APIs: 

 ProjectFinance: Current project finance table and its values.  
 ProjectFinanceStructure: Current project finance table structure and associated metadata. 
 ProjectFinanceSnapshot: Project finance snapshots, the values they contain, and their metadata.  

The following table displays the supported actions for the API objects. 
  
Object Create Read Update Delete 
ProjectFinance No Yes Yes No 
ProjectFinanceStructure No Yes No No 
ProjectFinanceSnapshot Yes Yes Yes Yes 
  
Gateway Provider: The Instantis Gateway Provider enables communication between EnterpriseTrack and Primavera 
Gateway to provide full integration with Oracle Primavera products and other Gateway providers out of the box. 
  

  
Other technical enhancements: 

 EnterpriseTrack is now supported on Google Chrome browsers. 
 Microsoft Internet Explorer 9 is supported in EnterpriseTrack 9.0 but may not be supported in the next 

release. 
 The following components and versions are not supported in EnterpriseTrack 9.0: IE 8, Windows Vista 

 




